Develop SAP Business One extensions on the
SAP Cloud Platform
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The objective of this hands on is to put in practice how to develop SAP Business One extensions on SAP
Cloud Platform.

The exercise will be composed by

- Step 1: Create a Fiori application connecting to SAP Business One Service Layer via SAP API
Business Hub

- Step 2: Implement a server side NodedS application

- Step 3: Deploy the NodeJS application to SAP Cloud Foundry

- Step 4: Consume the server side NodedJS application from the Fiori application

This hands-on exercise will require several steps, please follow them in the proposed order as each step is
counting on the precedent steps.




PREREQUISITES

i. Download and Install Development Tools

Download and install git version
control on your system from the
following link

https://qgit-scm.com/downloads

© git

About
Documentation Downloads -
Downloads Latest source Release

GUI Clients , 2,16.2

Logos @ MacOSX  4F Windows Release Notes (2018-02-15)
Community { Linux/Unix Download 2.15.1 for Mac

Older releases are available and the Git source

repository is on GitHub.

e Pro Git book

We will also make use of SAP
Cloud Platform Cloud Foundry
Environment.

To do so, we need the Cloud
Foundry command line interface
(CLI)

You can download it and install
if the CF CLI for your operating
system on.

https://github.com/cloud

foundry/cli#downloads

Downloads

Installing using a package manager

Mac OS X and Linux using Homebrew via the cloudfoundry tap:
brew install cloudfoundry/tap/cf-cli
Debian and Ubuntu based Linux distributions:

# ...first add the Cloud Foundry Foundation public key and package repository to your system

wget -q -0 - https://packages.cloudfoundry.org/debian/cli.cloudfoundry.org.key | sudo apt-key add -

echo "deb https://packages.cloudfoundry.org/debian stable main" | sudo tee /etc/apt/sources.list.d/cloudfo
# ...then, update your local package index, then finally install the cf CLI

sudo apt-get update

sudo apt-get install cf-cli

Enterprise Linux and Fedora systems (RHEL6/CentOS6 and up):

# ...first configure the Cloud Foundry Foundation package repository
sudo wget -0 /etc/yum.repos.d/cloudfoundry-cli.repo https://packages.cloudfoundry.org/fedora/cloudfoundry—¢
# ...then, install the cf CLI (which will also download and add the public key to your system)

sudo yum install cf-cli

Installers and compressed binaries

Mac OS X 64 bit Windows 64 bit  Linux 64 bit

Installers pkg Zip rpm / deb

Binaries tgz zip tgz




ii. Create a SAP Cloud platform trial account

The exercises proposed in this hands on are implemented on top of the SAP Cloud Platform.

If you have already a trial SAP Cloud Platform account, you can skip this step.

To create a trial SAP Cloud Platform account, go to the following link:

Explanation

Screenshot

To create a trial SAP Cloud
Platform account, go to the
following link:

https://account.hanatrial.ondemand.

com

Press the Register button

SAP Cloud Platform g

£y Home [Europe (Rat) - Trial]

& Home - Overview

Register |

SAP Cloud Platform

Develop, extend, and run applications in the clou

R —

Enter all your details

Registration

Tell Us About Yourself

First Name
Last Name ™

E-Mail *

Set Password

Password

Re-Enter Password *

Contact Preferences

Accept the terms and conditions by
checking both check boxes and
press “Register”.

Terms and Conditions

¥ | acknowledge that | have read SAPs Privacy Statement *

[ | have read and understood the Terms and Conditions of SAP Cloud Platform. *

*Required

C--)




iii. Activate Web IDE Full Stack service

We will use Web IDE Full Stack for the creation and implementation of our application.
Web IDE is offered as a service on the SAP Cloud Platform.

To activate Web IDE Full Stack service please follow the steps here below, if you already have Web IDE Full
Stack service active in your account please skip this step.

Explanation

Screenshot

Open your trial SAP Cloud
Platform account from the
following link:

https://account.hanatrial.ondema

nd.com

Press the Log On button if you
are not automatically logged in

SAP Cloud Platform Cocky

£y Home [Europe (Rot) - Trial]

Develop, extend, a

et 50T T

nd run applications in the cloud

. - P

After login if you are proposed
between Cloud Foundry Trial
and Neo Trial please choose
Neo Trial.

3 Home [Europe (Rot) - Trial]

Your SAP Cloud Platform Trial

Cloud Foundry Trial Neo Trial

Infrastructure: SAP
Trial Duration: Unlimited

Infrastructure: AWS.GCP, or Azure
Trial Duration: 90 days limited trial




Explanation Screenshot

Selegt the Services icon on the SAP Cloud Platform Cockpit
left side bar.

7y Home [Europe (Rot) - Trial] & Europe (Rot)- Trial =l i029182trial

=

__@ | B Subaccount: i029162trial - Services
{ ) A4t
=

&

Analytics

2 §: Predictive Service ¥ Smart Business Service

©

Perform predictive analysis on data o Helps visualizing and embedding
0 ‘°~d in your SAP HANA dalabase on l Q analytical content in individual Fiori
SAP Cloud Platform. applications. tiles and interactive
@ dashboards.
Enter Web in the search edit S = 5o 0
text.
ClICk on the SAP Web |DE FU" Overview A Home @ Europe (Rot)-Trial v & trial
Stack box. 2 e ¥ Subaccount: trial - Services o ®
Services. Filtered: 2 of 50
Solutions All Categories | web| ®
@ SAP HANA/SAP ASE DevOps
Connectivity ¥ SAP Web IDE ¥ SAP Web IDE Full-Stack
secuy D Lot craved
A web-based tool that enables you A web-based IDE that enables you
b to create and extend end user to create and extend end-to-end
applications for browsers and SAP multi-cloud applications for
Resource Consumption mobile devices browsers and mobile devices
lick Enable. :
C C b e %y Home @ Europe (Rot) - Trial = trial ~ B5 SAP Web IDE Multi-Cloud Version s
This may take a few
minutes. s Service: SAP Web IDE Full-Stack - Overview
Not enabled
Enable
L
Service Description Availability

SAP Web IDE, multi-cloud version is a powerful, extensible,
web-based integrated development tool that simplifies end-to- Regions [l Europe (Rot)
end application development for SAP Cloud Platform. Build,
debug, test, extend and deploy apps using wizards, templates,
samples, code and graphical editors, modelers, and more

In addition, Principal Propagation will be enabled for your
account once enabling this service.

Europe (Rot) - Trial
US East (Ashburn)
US West (Chandler)
Documentation US East (Sterling)
Australia (Sydney)

Japan (Tokyo)

E-ERNERRE

China (Shanghai)




Explanation Screenshot
Once Enabled select the SAP Cloud Platform Cockpit
“nk GO tO Seerce tO Open "5} £y Home [Europe (Rot) - Trial] & Europe (Rof)- Trial ~  [5] i029162trial ~ & SAP Web IDE Full-Stack

Web IDE Full Stack.
& Service: SAP Web IDE Full-Stack - Overview

Service Description
SAP Web IDE for Full-Stack Development is a powerful, extensible, web-based integrated development tool that simplifies end-
to-end application development for SAP Cloud Platform. Build, debug, test, extend and deploy apps using wizards, templates,

samples, code and graphical editors, modelers, and more
In addition, Principal Propagation will be enabled for your account once enabling this service

Take Action
Configure Service
Logs

Go to Service

Web IDE opens with an Edit Build Run Deploy Search View Tools
empty Workspace unless
you already developed
applications with Web IDE
in the past. S Workspace




iv. SAP API Business Hub

SAP API Business Hub is the central catalog of all SAP and partner APlIs for developers to build sample
apps, extensions and open integrations with SAP.

SAP Business One has exposed 3 packages as of today:
- SAP Business One — Sales
- SAP Business One — Business Partners
- SAP Business One - Inventory

Many other packages will follow very soon, stay tuned.

Please go to the following link for more details:
https://api.sap.com




STEP 1: CREATE A SAP FIORI APP CONNECTING TO SAP BUSINESS ONE SERVICE LAYER VIA
SAP API BUSINESS HUB

The objective of this first exercise is to develop a SAP Fiori app using the SAP UI5 template.
Service Layer provides OData v4 support since SAP Business One 9.3 PL04 version for SAP HANA.

In this exercise, we will use the Service Layer APIs exposed via the SAP API Business Hub, please refer to
the prerequisites section SAP API Business Hub for more details.

Web IDE supports OData v4 on some templates like SAP Fiori Worklist Application OData v4 and SAPUI5.
More templates will support OData v4 gradually. In this exercise, we will use the SAPUI5 template.

i. Create a SAPUI5 Application

Explanation Screenshot

Open SAP Web IDE Full Edt Build Run Deploy Search View Tools Help
Stack.

Check the prerequisites
sections “Create a SAP
Cloud platform trial
account” and “Activate
Web IDE Full Stack
service” if you don’t
know how to open
WebIDE Full Stack.

Right click on your
Workspace and select New
-> Project from Template.

Build Fin Deaphoy Search Wiew Tools Healp

[emipeat W Foidar : ™ by
i Prajact from Sample Application
Cick Start with Layout Editor

Exlension Propct

10



Explanation

Screenshot

Select the SAPUI5
Application template.

Press Next.

If you don’t see this
template, change the
Category to All
categories.

Template Selection  J=EEIELIETL] Template Customization

New SAPUI5 Application
Template Selection

Search Category Sort By

=t Featured ~ Sort by recently used

Lo =@

SAP Fiori Worklist Multi-Target Application
Application OData V4

MNext

SAPUIS Version

~ SAP Innovation (1.54)

[

(4

SAP Fiori Master-Detail
Application

Enter a Project Name.
Enter a Namespace.

Press Next.

Template Selection Basic Information Template Customization Confirmation

New SAPUI5 Application
Basic Information

Project Name* B1SL_SUMMIT_2013

App Descriptor Data

-
MNamespace sal

Previous MNext

Keep the Initial View
Details with the default
values.

Press Next.

Template Selection ESMLIGIEN N  Template Customization Confirmation

New SAPUI5 Application
Template Customization

Initial View Details View Type* XML

View Name View1

Previous Next Finish

11



Explanation

Screenshot

Press Finish to confirm the
creation of the SAPUI5
template.

Template Selection

Basic Information Template Customization

New SAPUI5 Application

Confirmation

Click Finish. A new project named B1SL_SUMMIT_2018 will be created in your workspace.

Previous

Fimish

Confirmation

12



ii. Add a Data Source to the SAPUI5 Application

Explanation Screenshot

In Web IDE select your
project and right click to get
the menus.

Edit Build Run Deploy File Cirl+Al+N

Import Folder Ciri=Al

- B Export Project from Template Ctri+AR+Shift+0 |
£l mannescjson Enable App to App Navigation Project from Sample Application
Select New -> OData _
Service = hpre Cut Quick Start with Layout Editor
i L Copy Cirl+C Extension Project
= neo-app.ison
R tri+ OPA Page
= package json
B1SL HUB_UI5_EX1 F2 OPA Journsy
5 B1SL SUMMIT 2018 Delete QUnit Test
i Run s SAPUIS View
weba
— i Build OData Service
E .npmrc ———
E Gruntilejs Git 5 Annotation File
E neo-appjson Deploy HTMLS Application Descriptor
E package-ock json Project Settings i i
= packagejson R

Select SAP API Business :

x
Hub in the Sources (left
side of the screen). New OData Service
Data Connection
Select the “SAP Business SRR e
One - Sales” API package
from the dropdown control.
5 = Description
_jn e S A commitment from a customer or lead to buy a product or
) Warkspaos senvice.
You might be prompted to R S
enter your SAP Community Sanvios URL nvoices Authentication Required x
User Name and Password.
Enter your credentials and
press Log In.
Pt [Ea
Next
LogIn Cancel =
S 75@% "
From the available APIs
presented select Orders
and make sure the New OData Service
“Service: Orders Data Connection
selected” blue message is
shown at the top of the
Data Connection tab.
- = Description
Press Next. R = A commitmant fom 3 customer or lesd to buy & product o
File System
Service URL Invoices

API Details

e 1.0

08 Feb 2018

12 Mar 2018

13



Explanation Screenshot

In the Model Selection step
keep the radio button “Use
default model” to create a
default model associated to
our OData Service.

Confirmation

New OData Service
Model Selection

Define model service for the appécation.

Press Next.
Appiication Model ® Use default model
Create new model

Madel name

Previous Mext

Press Finish.

| ; = ; TG
| Data Connection | Model Selection el OIEENTT]

New OData Service
Confirmation

Click Finish. The selected OData service is connected to the B1SL_SUMMIT_2018 project.

Previous Finish
A new Data_ Source and its File Edt Buld Run Deploy Search View Tools Help B © M3
corresponding Default Bl ro it~ [0 =
model is added —_—
3 ~ & ® &0 manifest.json %
automatically to your o \
prOjeCt. =] W::izi\cisps Settings  Data Sources Models Routing  Navigation

B1SL_AWS_BPS
B1SL_AWS_WL4_!
B1SL_SUMMIT_2(

OData Services

Right click on the
webapp/manifest.json file

Define OData services for the applicatio...

g OEEa

and select Open With -> = -':::app _ I uni e ;
Descriptor Editor. coritrdilar =
Local .. ocalxervice
Select the Data Sources i18n ODat. |4
tab localService
’ = modsl Servic.. Sync Metade

view

Check that the Orders
OData service has been
added, points to the API
Hub url and the version is
4.0.

Component.js

index.html

manifest.json
Descriptor Editor Code Editor
——

14



Explanation

Screenshot

In the same file

webapp/manifest.json as in

previous step select the
Models tab.

Select the Default model

and check:
- the Default
checkbox is
selected

- the Data Source

is Orders

Edit  Build Run

Deploy Search \View Tools Help

&
~ & ® 8
<> =] Workspace
BT B1_APLBPs
71 BT BISL_AWS_BPS
B B1SL_AWS_WL4_SU
[=d = 5151 summiT 20
B che
7 B webapp

controller
css

i18n
localService

model

Component.js
index.html
manifest.json

npmrc

Gruntfile js

manifestjsan X

Settings ~ Data Sources  Models
—

Models

Define mode

il8n

Default

Descriptor Editor Code Editor

Routing

for the application an

+

=]

N

Navigation

Group ID | Sdirect

Data Se... | Orders

URI

Preload | true

Operati... | Server

b

15



iii. Add controls to the View1 view.

Select the Entity Type
Explanation Screenshot

Open the view folder.

Euiid Tools

Ru

Help

Open the
View1.view.xml file with
the Layout Editor.

Layout Editor

Code Editor

Import

Export
B1SL_SUMN i
5 che Cut Cirl+x
webapp Copy Cirl+C
controfie Paste Clrl+V
CSs
Rename F2
i18n
, Delete Deiete
localSer
maodel Run i
view Git »
Deploy B

£l Compon ) ,
=3 Project Settings
=l index.hti
=1 manifes! Refresh

El .npmrc

Select the Outline tab.

Select View.view.xml.

DT o c[E e
On the Properties tab 7 i i e ®
(right side of the screen n : _ @
Layout view screen) check = = B
if IOrders is already @ o celtarvion = | =
entered as the associated i o
Entity Set. @ Deistaiema a
© Dizogfagmar o
Miew!.wew.xm
= Comporertjs T
& indexhim| <
B manifestjson
= mre B

If /Orders is not yet entered

follow the next steps to . B R index i ~ G
define the Entity Set. ~ & m o6 | Vewlvewm x | o
BISL SUMMIT.20 . 0g E *
If /Orders is already 2 o Z = &
i . szl Controls Outline Properties  Events
available go to the next _ contralier
section “Add a sap.m.Table | i - St [ - B
control”. @ e ki B
. S Hrers .
- ~ sapm. App ol
. = T osasvens ‘-"a-__s-v;u 5 or property a e
Click on the button to TR i Element ID
select the Entity Set £ Gt
H 0 = v Mama
associated to our view. & isexiird b 7

16



Explanation Screenshot

Check the second option
Define dummy entity
set... and choose the
[Orders Entity Set. Entiy Sai  Notdefned

Select Entity Set

Press OK. D Define dummy 1!. sat for the selacted control. This will ba used nly by the layout editor. (3

Orders

Once back to the Layout

Editor the /Orders entity S
should be shown. ~ & e8| Vewlvewsm x| o
BISLSUMMIT.200 oo E
Press Save button. 7 T &
= ! |: XML View &
e = =
s
View Namea
&

17



Add a sap.m.Table control

Expand sap.m.Page.

Right click on content
and select Add.

-~

» B1SL_SUMMIT_2018

| f] [

& 69

View 1. viewxml =

View » App » Page

: i Convert to Fragment
7 webapp Controls Outline
~ ~— Add Fragment
controller
=] css -~ cut trl+X
_:-'_' Lo Search Cirl=C
= localService Cirl+
— v Viewd view xmi -
modet
= view MESAPALERD
Viewd viewxml ~heEe
=l Component js ™ sap.m,Page Jelete Delete
B el | comem T
e S customHeader
=l manifestjson
footer
apmre
Gruntiile js subHeader
headerContent
neg-app.json
landmarkinio

[

package-lock. json

Enter table to filter the
controls shown in the list.

Click on the Table control
so it will be added to our
view.

Add Control to: content

| ‘ table|

ooo
ooo Table
ooo __—

On the table created edit

each sap.m.Table ->

columns ->

sap.m.Column -> header

-> sap.m.Label Text

Property:
- Change Header 1

by DocEntry.

- Change Header 2
by CardCode.

- Change Header 3
by DocTotal.

Viewl.viewxml =

View > App > Page » Table » Column » Label & =5 E Do Lay
Controls Outiine Properties Events
~ [} Label
Search Q Entity Set
= JOrders =
> items {Orders} DocEnirny CardCode DocTotal
swipeContent
heacerTooloar Row 1 Caf Row 1Cell 2 Row 1Cell 3 Seadciiior pogety g Q
infoToolbar [Tempizie] Element ID
~ columns __labelo
~ sap.m.Column
o Text
~ header
DocEntry &
sap.m.Label —
Tooter Busy
~ sap.m.Column false - &

o hasrar

18



Select each one of the
items ->
sap.m.ColumnListitem ->

*View1 viewxml *

Visw > App > Page > Table > Column List tem > Text

QQE D D ey

Controls Outling Properties Events
cells -> sap.m.Text cell to =
bind them to their 5 ! TE’:: [
. Searek Q ntity Sef
Corresp_ondlng Orders ~- Htems forders DocEntry CardCode DocTotal et &
propertles. v sap m.ColumnListitem
~ cells Row 1 Cell 2 Row 1 Cell 3 Seardior prapety rame &
On the Text property click Rsn
- - < __texd
the Binding button on the sapmText -~
right side of the Text Sppecomat Row 1.Ca]
headerToolbar
property infoToolbar Busy
~ columns false ~| &
~ sap.m.Column Busy Indicator Delay
=an m | ahal
Delete the default

Expression string.

In the Search for data field
enter the name of the
Orders property DocEntry.

Double click on the field
name so it will be copied to
the Expression string
between curly brackets.

Repeat this step for
CardCode column.

Data Binding [Text]

Bind the Text property of the Text control by double-clicking an entry or by typing an expression.

Data Fields

DocEntry

w [Orders

= DocEntry (inf32]

= DocumentAdditionalExpenses/

Expression (siring)

{DocEntry}
——

= DocumentAdditionalExpenses/
= DocumentLines/DocEnfry (int3:
= Documentlines/DocumentLine

Documentlines/GeneratedAss

DocumentlLines/LineTaxJurisdi

Cancel

For the DocTotal column
we will add 2 properties:
- DocTotal
- DocCurrency

We will then search and
add first the DocTotal and
afterwards search and add
the DocCurrency.

Press Save button <~ on
the View1.view.xml file.

Data Binding [Text]

Data Fields Expression (siring)
DocCurrency ® Q {I ency}
~ /Orders

= DocCurrency (string)

Bind the Text property of the Text control by double-clicking an entry or by typing an expression

0K

Cancel

19



Your View1.view.xml
layout should look like this
at this point.

View1.view.xm

Vizw » App > Page > Table » Column List tem » Text

. oF) B -

Click on the green arrow to
run your application.

Controls Outiine Properties Evenis
- i i Text
Searc Q Entity Set
= i s 0
~ View! view xmi DocEntry CardCode DocTotal Orters =
~ sap.m.App
~ pages {DocEntry) (CaraCode) Search for property name Q
s s Element ID
~ content tex2
~ sap.m.Table —
1 Text
~ items {Orders}
= sapm ol e {DocTotal}{DocCurrency} &
~ celis Busy
sap m Text false ~| &
3| Text
b Busy Indicator Delay
Edit Build Run Deploy Search View
. Ciy =42 o =
285 e <
Ly

B1SL_SUMMIT_2018

.che
o
%4 webapp
controfler
i Css
i18n
i z s
&) localService
model
A new tab opens showing -
your application. e
. DocEntry CardCode DocTotal
You can see the Table is
automatica”y filled with the 2 C30000 2 976 88%
list of Orders available in
the APl Business Hub 3 C40000 12,5358
sandbox running SAP
BUSineSS One_ 4 C23900 7.473%
5 C42000 18,391%
6 C30000 8,795.31%
7 C40000 10,573%

20




Add a Search Field control to the sap.m.Table

Explanation Screenshot
Open the -
. R . . 2 Save i ~ . = =
View.view.xml file with Cro i Rl 2ol ® < :
the Layout Editor. ~ £ | B8 View!viewxml *
Go to the Outline tab = B1SL_SUMMIT_2018 s A
and select sap.m.Table o
-> headerToolbar.
= webapp Controls Qutline
7] controiler
Right click to get the [ css - T s
context menus and = i1an e - -
select Add. = |sealSenice . Convert to Fragment
=) model ~ View T view.xmi Add Fragment 4
= view AR Cut Cir+
View1.view.xml il oo cii+c g
=! Component js ¥ EaRm.Ea0 — . L
Faste Cir+V o
= index htmi > fonien F
o Al ~ Sap.m. Faste BEefors
i=! manmesyjson
o > item Paste Afte
=l .npmrc . asie Afte
= Gruntfile s W holate Delete
T! { o o

nec-app.json

Click on the Toolbar
proposed control.

Add Control to: headerToolbar

&l

=1 Overfiow Toolbar

E Toolbar

21



Explanation

Screenshot

Go to the created
sap.m.Toolbar -> content
element and right click to
select the Add menu.

=\iew 1. view xmi

%

Wiew » App » Page » Table » Toolbar

Controls Outline
Add
~ 4+ Convertio Fragment
Search Add Fragment
~ content -
~ sap.m.Tablg i SLiEs

» ftems{or  Fasie Ciri+V
swipeCon

~ headerTol Paste Afie iy}
~ sap.m.] i

infoToolbar

Enter SearchField to filter
the controls.

Click on the Search Field
proposed control.

Add Control to: content

[ ‘ SearchField

Q Search Field

Select the
sap.m.SearchField control
in the Outline tab.

Select the Events tab in
the right side of the screen.

On the Search event click

on the button and
select New Function
option.

*View!.viewxmi =

View > App > Page 5 Table » Toolbar ) Search Fisld

Controls  Outline Properties  Events
~ + T Search Field
Search Q Search for event name Q
~ sap.m Table Search Q Suggest
> items {Orders}
swipeContent DocEntry CardCode DocTotal Live Change
~ headerToolbar
~ sap.m.Toolbar
{DocEntry} {CardCode} {DocTotal, Search
~ content —
DocCurrency}
~ sap.m SearchField [ Esp
suggestionltems Validate Fietg  Navigate To
infoToolbar Select Function
2 golinne Model Contey ~ NEW Function
citomoades Open in Editor
footer
I _ e

cE B -

22



Explanation

Screenshot

Enter onSearch as
function name that will be
called when the Search
button will be pressed.

Press OK.
Press Save.
A new function with that

name will be created in the
View.Controller.js.

New Function

The new funciion will be added to the controller of the current view.

Enter a function name:

Cancel

Open the
View1.controller.js file.

Copy the code from

https://github.com/B1SA/B
1 _SCP_HandsOn/blob/ma
ster/snippets/View1.controll

er.js_onSearch.js into your
onSearch method so it

looks like here.

This code filters the Orders
with DocEntry greater or
equal than the value
entered in the SearchField.

Press Save.

)
i
3
{
®

5 B1SL_AWS_WL4_SUMMIT

=7 BISL_CHN
+] B1SL_Doel

T BISL_HUB EX1

“5 BASL HUB_ UIS EX1
B1SL_SUMMIT 2016

e che
webapp

= conoller

[}

ais controller 5

= css
7 isn
oos(Service
=1 model

= view

[E Detaisviewxmi

\iew! controflerjs

1= =3

ot
a-

onéearch; function|
—

Run your application.

Run indes hitmi

23



Explanation Screenshot
Check that the SearchField
filters the table with Orders Tiile
having a DocEntry higher
oo, T
than the entered value. | 1200 ® Q
DDEEHU’}" CardCode DocTotal
1,200 1103914 5,0008
1,201 1103914 5,000%
1,202 1103914 5,000%
1,203 1103914 5,0008
1,204 1103914 5,000%
1,205 1103914 5,000%
1,207 20000 191575
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iv. Add a second view called Details
Create a Details view.
Explanation Screenshot

Right click on your
application and select New
-> SAPUI5 View.

Edit Build Run File

Import Folder

Export Project from Template

b i Enable App to App Navigation Project from Sample Application

LA St Quick Start with Layout Editor
Dialog fra
PR ’ cirle
et v Copy Cri+C Extension Project Ctrl
Componeni Paste Cri+V OPA Page
index.htmi Renams F2 OPA Joumey
El manifestjst Delete QUnit Test
Ll Run > OData Service
Gruntfile js )
AsGSmpSe Build SAPUIS View
I package json Git N Annotation File
B15L_HUB_UI5 Deploy N HTML5 Application Descriptor
B bt
Project Settings
Refresh B 01nGINg
webapp xr var zase-— wnis.getView
controller 18 var binding = list.getBi

t+Shifi+E

Keep the default values for
View Type and
Namespace.

Enter the name of the new
View: Details.

Press Next.

Template Customization Confirmation

New SAPUI5 View
Template Customization

Initial View Details
View Type* XML

Mamespace sa.B1SL_SUMMIT_2018

View Name* Details

Next

Press Finish to confirm the
creation of the Details
view.

New SAPUIS View

' '
ki

Click Finish, A new compenant i created at B1SL_SUMMIT_2012Awebapp

Owenarite exisling component

Pravious Finksh
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Explanation Screenshot
Two files are created: B1SL_SUMMIT_2018
- Details.view.xml che
- Details.controller.js. webapp
controlle

[E Detais.controllerjs

View1.controller.js
css
12n
ocalService
meodel
view

Delais viewsml

o)

View1.view.xml

Add an Object Header control.

Explanation

Screenshot

Open the
Details.view.xml file
with the Layout editor.

Go to the Outline tab.

Right click on
Details.view.xml ->
sap.m.App ->
sap.m.Page -> content
and select Add.

Dretails viewxml =

View » App » Page

Controls Outh
— Add Fragment
Search Con
~ Details.view.xmi Paste
V" sap.mApp Paste Befare
~r pages s wi

~ zap.m._Pag

customHeader
footer
subHeader
headerContent

landmarkinfo




Explanation

Screenshot

Enter objectheader to
search for the Object
Header control.

Click on the Object
Header proposed control.

22

Add Control to; content

objectheade

[==H Object Header

Select the created
sap.m.ObjectHeader
element in the Outline tree.

Go to the Properties tab in
the right side of the screen.

Click one by one on the
Data Binding icon for the
properties:

- Title

- Intro

- Number

- Number Unit

*Delails viewxml x

Visw ) App > Page > Object Header

Controls Outline

- oE B -

~ + T

Search

[Object Header|

~ Details view:xm
v sap.m.App
~ pages
~ sap.m.Page
~ content
attributes
firstStatus Deprecated

Title

Title

Intro text

123

eur

Deprecated
statuses
additionalNumbers
headerContainer
markers

Properties  Events

Object Header
Entity Set
iQrders

Search for property name
Title
Title

Intro
Intre text

Number
123

Number Unit

_ =

A new dialog will be
presented for each one of
the properties.

Search for the Orders Data

Field to be assigned to

each property:

- Title -> CardCode

- Intro -> DocEntry

- Number -> DocTotal

- Number Unit ->
DocCurrency

and double click on the
proposed list to get it into
the Expression string.

Data Binding [Cbject Header]

Bind the Title property of the Object Header conirol by double-clicking an eniry or by typing an expression

Data Fields
DogEpt & o

N -
~ [Orders
~ DocEnfry (int32)
= DocumentAdditionalExpenses/

« DocumentAdditionalExpenses/

« DocumentLines/DocEniry {int3;
= DocumentLines/DocumentLine
= Documentlines/GeneratedAss

= Documentlines/LineTaxJurisdii

Expression (siring)

{DocEnt
{DocEntryl|

Cancel
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Explanation Screenshot

Note: Do not select

BusinessPartners/CardC Data Binding [Object Header]

ode for the CardCode
property. Bind the Title properny of the Object Header controf by double-clicking an eniry or by typing an sxpression

Data Fields - Expression (string) =
Press Save button. == s a s

w [Orders

w BusinessPariner
= BPBiockSendingharketingC
= BPintrastatExtension/CardC
= CardCode (Shing)
= ContactEmployeesiCardCor
* CreditCardCode {int32)

» CardCode {string)

w» LandedCost

OR Cance!

The sap.m.ObjectHeader iTTr——
should look like this at this S 0 QE & -

point.
Controls Outline Properties Events
~ + =
Title Object Header
Search Entity Set
Object Header o
~ Details.view.xmi [Orders T
* sap.m App
~ pages {DocEntry} Search for property name a
~ sap.m Page =
~ content {CardCode} {DocTotal} Title
{CardCode} &

{DocCurrency}

~ sap.m.ObjectHeader
Intro

attributes
TirstStatus Deprecated {DocEntry} @
Deprecsted Number
statuses {DocTotal} &
additionalNumbers
MNumber Unit

headerContainer
) {DocCurrency} a
markers
customHeader Background Design




V. Define navigation between View1 and Details.

Explanation

Screenshot

From our main View1 table
we want to navigate to
Details view when the user
clicks on a row.

Open View1.view.xml file
with Layout Editor.

Select Outline tab
View1.view.xml| ->
sap.m.App -> sap.m.Page -
> content -> sap.m.Table ->
items ->
sap.m.ColumnsListitem.

Select the Events tab.

: o[ [

Columa List Item

Clickonthe ° icon.

Select Navigate To menu.

Properties Events

Column List ltem

Search for event name

Detail Press

Press

Detail Tap

Tap

Validaie Field Group

Navigate To

Select Function
New Function

Cpen in Editor

Select Propagate current
context on the Data Binding
combo box.

Select Details on the View
combo box.

Press OK.

Press Save to save the
View1.view.xml changes.

The selected Order data
from the View1 will be bound
to the Details view.

Data Binding

Navigate To

Propagate current context

*View

= -
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Explanation

Screenshot

From our Details view we
want to navigate back to our
main View1 when the user

*Details viewxml x

View » App > Page

o ol BEE -

. Controls Qutiine Properties Events
press on the Navigate back
button. Sl < Title Page
— Entity Set
A s - Details. view xml 10rders o
Open the Details.view.xml i
file with the Layout Editor. ~ pages {DocEntry} |Search for property name Q
9
. ot {CardCode} {DocTotal} i ~|#
Go to the Outline tab and customHeader {DocCurency} Show Nav Button _
Py {n ~ &
select sap.m.Page. s it
subHeader Show Sub Header
headerContent true ~ | &
On the Properties tab scroll Il Title Leval
dOWn tO see the ShOW NaV . __________________________________________________| == x|€
Button property and change
its value to true.
Go to the Events tab. )
Froperiies Evenfs
On the Nav Button Press
T Page
event click on the icon Search for event name e
. . Nav Button Press
Select the option Navigate 2 E
To.
Mavigate To

Nav Button Ti
Select Function
Validate Fielg ~ New Function
Cpen in Editor

Model Context Change

Select View1 on the combo
box.

We will navigate back to
View one when the Nav back
button will be pressed.

Click on the Save button.

Navigate To

*View

View1
—
Details

TargetView1

3l

Details

Test your app to see
navigation is working fine
between View1 and Details
view.

Run index htm e

Congratulations! You have created your first SAP UI5 application connecting to SAP API Business Hub
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STEP 2: CREATE A NODEJS APP

In this step we are going to implement the backend of our application. It will contain a simple business logic
to calculate freight costs from different providers and consume 3™ Party services. The application is written in
NodeJS and the source code is available on GitHub.

Explanation Screenshot
Once git is installed (accordingtothe | '@ ~ @ e nal A
pre requisites), open your system [bash-3.25 I

terminal (cmd, bash..)

Navigate to a specific folder where
you will download a sample
application.

Pay attention what folder is it, we will
access it later

Execute the following command to ‘o0 @
clone our solution backend repository:

Terminal — bash

llbash-3.2$ git clone https://github.com/B1SA/FreightCalculator.git
. {Cloning into 'FreightCalculator'...
$ g|t Clone remote: Counting objects: 65, done.

. i H ‘remote: Compressing objects: 100% (43/43), done.
https.{IQ|thub.com/B1SA/FrelqhtCaIcuI | remote: Total 65 (delta 26), reused 49 (delta 15), pack-reused @
ator.glt Unpacking objects: 100% (65/65), done.
bash-3.2% [l

You can see the app code on your file | o e ;
explorer: < 3 B w o

handson

= %y B O 3y Q
Favorites Name A Date Modified size
@ Ardrop
«d app.js 9:48 1KB
o ponloecs LICENSE 1KB
=1 OneDrive - SAP SE 4 manifestyml 132 bytes
/3 Applications A/ modules ==
A freight.js 2KB
[ Desktop 4 package.json 743 bytes
33 Dropbox v public ==
. v mjs -
s 4 calls.js KB
[ Ralph's MacBook Pro - README.md 1kB
(©) Remote Disc v I views
= B index.htm! 2KB
[} VADER_T3 a
Edit the File manifest.yml and set a : S
unique name for your application. - maniestymi @
E.eg FreightCalc<Your Initials> 1. ==
2 applications:
3| - name: freightcalcRo|
4 memory: 64m
5 instances: 1
6 buildpack: https://github.com/cloudfoundry/nodejs-buildpack.git
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STEP 3: DEPLOY THE NODEJS APP INTO SAP CLOUD FOUNDRY
In this step, we are going to deploy our Freight Calculator app to SAP Cloud Platform Cloud Foundry.

Explanation Screenshot

First, we need to activate the
SAP Cloud Platform Cloud
Foundry Environment.

On the SAP Cloud Platform

SAP Cloud Platiorm Cockpit

Overview | & Home [Europe (Rot) - @ Europe (Roy-Trial v | [= i0291621ral

Applications B] Subaccount: i029162trial - Overview

=]
)
: B Services
Dashboard click on the HOME System Status
option [ Solutions
@ SAP HANA / SAP ASE JAVA HTRLS
Overall Health 4 Applications Overall Health
®,  Connectivity
4  Stopped
B Security O O
13 Repositories
N/A N/A
First, we need to activate the PTr—

SAP Cloud Platform Cloud P ————
Foundry Environment.

From the SAP CP Home

Your SAP Cloud Platform Trial

Screen, click on Cloud Foundry Cloud Foundry Tral Neo Tral
- el Infrastructure: AWS,GCP, or Azure Infrastructure: SAP
Tr| al s Trial Duration: 90 days limited tral Trial Duration: Unlimited

Select the Trial Region that most
suits you. And Click on OK Stark Crauc|oundryiitia)

*Region Europe (Frankfurt) v

You can start your free trial in any of the supported Cloud
Foundry regions. Once started, you will be able to fully
explore additional runtimes like node.js and use new
services.
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Explanation

Screenshot

This will initialize your Cloud
Foundry Trial and create a DEV
space (where the solutions will be
deployed). Go Ahead and access
your space.

Start Cloud Foundry Trial

Region: Europe (Frankfurt)
Global Account: P2000186662trial
Subaccount:  trial
Organization: P2000186662trial_trial

Space: dev

Go to Space

Your space is created and ready to
deploy your app. We now need your
environment endpoint to be able to

SAP Cloud Platform Cockpit

£ Home [Europe (Rot) - Trial] | @ Europe (Frankfurt) v | f P2000194154trial (& trial

© Space: dev - Applications ]
pUSh our app Al:0
. ) ) 2 Deploy Application
Click on the trial link
State Name Instances Disk Quota Memory Actions
No applications
And then on Overview option in Ho m =

the menu

 Home [Europe (Rot) - Trial] | @ Europe (Frankfurt) v | B P2000184154trial | & trial

& Subaccount: trial - Overview

Select and copy your API =
Endpoint. E.g.
Subaccount Details Cloud Foundry
. Subdomain: p2000194154trial Organization: P2000194154trial_trial

https : / / api . c f . eu 1 O . hana = 1D: 77ffc16d-584b-4cf9-b9ab-6ac52b232d52 Spaces: 1

API Endpoint:  https://api.cf.eu10.hana.ondemand.q
.ondemand.com S

Disable Cloud Foundry

With the CLI installed . (] Terminal — bash

(according to the pre

bash-3.2$ cd FreightCalculator/

. bash-3.2% 1
requisites), open your system | igensi  app.is - rron
terminal and navigate tO the README . md manifest.yml package.json views
bash-3.2$ JI
folder of the backend app
cloned on STEP 2 of this guide
From that folder, login to Cloud | ' ® © ® Terminal — bash

foundry using the command

cf login -a <API
ENDPOINT>

eg.

$ cf login -a
api.cf.eull0.hana.ondeman
d.com

When prompted provide your
SAP Cloud Platform email and
password

!lbash-3.2$% cf login -a api.cf.eul®.hana.ondemand.com
API endpoint: api.cf.eul®.hana.ondemand.com

| Email> sipemsbh@sharklasers.com

[Password>

Authenticating...

| 0K

|
Targeted org P2000194154trial_trial

Targeted space dev

API endpoint:
User:
| org:
Space:
bash-3.2$ I

https://api.cf.eul®.hana.ondemand.com (API version: 2.101.0)

sipemsbh@sharklasers.com
P2000194154trial_trial
dev
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Explanation

Screenshot

Now all you have to do is push your
app to the SAP Cloud Platform Cloud
Foundry by using the command:

cf push

@ @® Terminal — cf push

bash-3.2% cf push
Using manifest file /U

alph/OneDrive - SAP SE/handson/FreightCalculatol

Creating app f
s.com...

0K

jhtcalcRO in org P200019

ial / space dev as sip

alcro.cfapps.eul®.hana.ondemand.com...

nd.com to freightcalcRO...

Uploading freightcalcRO...
Uploading app files from: /Users/Ralph/OneDrive - SAP SE/handson/FreightCal

Uploading 5.3K, 11 files
Done uploading
0K

+trial_trial / space dev as sip|

Starting app freightcalcRO in org P20001

This process will read the manifest.yml
to name your application and also upload
and deploy all the artefacts in a container
in the Cloud Foundry Environment. Once
the Process finishes, you can see your
app URL:

requested state: started

instances: 1/1

usage: 64M x 1 instances

urls: freightcalcro.cfapps.eul@.hana.ondemand.com

last uploaded: Thu Mar 1 11:54:08 UTC 2018

stack: cflinuxfs2

buildpack: https://github.com/cloudfoundry/nodejs-buildpack.git

state since cpu memory disk
#0 running 2018-03-01 11:54:39 AM 0.0% 44 .7M of 64M 55.3M of 1G
bash-3.2$ I

This application makes use of a 3" Party service called Shippo to calculate shipping costs. In order to consume their

services, we need an APl KEY.

The Instructors of this hands-on session will provide a set of keys you can use in the next step. However, you can also
get your own FREE test key on their website https://goshippo.com/

Best practices of cloud development (see htips://12factor.net/config) suggests that any kind of configuration (such as
keys) should not be part of the codebase but set as environment variables. And that is easily done with Cloud Foundry

Back to the terminal, set the
Environment Variable SHIPPO_KEY
to a valid API Key with the following
command

cf set-env <appname>
<variable name> <variable
value

e.g.

cf set-env freightcalcRO
SHIPPO KEY shippo test 1234

000 : Terminal — bash

| bash-3.28 [ |

lbash-3.2$ cf set-env freightcalcro SHIPPO_KEY shippo_test_19385705180736e352abedb642306bf;2A

Setting env variable '
htcalcRO in org

' for app T

0K
TIP: Use ' g ght ' to ensure your env variable changes take effect
bash: 2A: command not found
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Explanation

Screenshot

Up next, restart your app

cf restart <appname>

® O Terminal — bash

bash-3.2% cf restart freightcalcRO
Restarting app freightcalcRO in org P2000194154trial_tri
rs.com...

Stopping app...

Waiting for app to start...

name: freightcalcRO
requested state: started
instances: 1/1
usage: 64M x 1 instances
routes: freightcalcro.cfapps.eul@.hana.ondema
last uploaded: Thu 01 Mar 11:54:08 GMT 2018
stack: cflinuxfs2
buildpack: https://github.com/cloudfoundry/nodej
start command: npm start
You can test the app with a test page on <« c @ ® @ https://freightcalcro.cfapps.e @ %  Q Search oDwe:
the app URL Ship Item To
Zip Code 01318001 Country BR
Shipment Estimation
# Provider Service Est. Days Amount
1 warsE. Worldwide 4 USD 94.24
2 B O e Priority Mail International 8 USD 54.82
3 = foiig Priority Mail Express International 4 USD 77.43

Congratulations! You have implemented and deployed your first Cloud Foundry application on SAP Cloud

Platform!
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STEP 4: CONSUME THE NODEJS APP FROM THE SAP FIORI APP

i. Add a Button “Add Freight” to the Details view.

Explanation

Screenshot

Open the
Details.view.xml file
with the Layout Editor.

On the Outline tab right
click on the sap.m.App
-> pages ->
sap.m.Page -> footer

element and select Add.

Details.viewxml =

Wiew » App > Page

Controls Outling
Add
-~ Conver to Fragment .
Title
Search Add Fragment
~ Details view.xml il Crl+X
~ sap.m.App Copy Crl+C
> paes Paste ctri+v {DocEntry}
ARl e Faste Before
» content i {CardCDdE}
customHe;
subHeader
headerContent
landmarkinfo

Select the Toolbar control
proposed.

Add Control to: footer
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Explanation

Screenshot

On the Outline tab right
click on sap.m.Toolbar ->
content and select Add.

Enter hbox in the Add
Control to: content new
dialog.

Select the proposed HBox
control.

Add Control to: content

[ | hoox

(IS Hmoe

On the Outline tab right
click on sap.m.Toolbar ->
content and select Add.

Enter button in the Add
Control to: content dialog.

Select the Button control.

Add Control to: content

=] | button

0 Button
<[> Paging Button

® Radio Button
@00 Radio Button Group
[I1] Segmented Button

(O Toggle Button

On the Outline tab select
the sap.m.Button.

On the Properties tab
change the Text property
by Add Freight.

View s App » Page ) Toolbar > Button,

Controls Qutiine
Search Q
~ Detaiiz view.xm
v sap.m.App
v pages
~ sap.m.Page
> content

customHeader
~ footer
~ sap.m.Toolbar
~ content
~ sap.m.HBox
items
subHeader
headgerContent

1 0E EE -

Title

{DocEntry}

{CardCode} {DocTotal}

{DocCurrency}

Add Freight

Properties Events

Button
Entity Set
JOrders =

Search for property name Q

Element ID
_ buttond

Text
Add Freight &

Active lcon

0
Y

Busy
false ~| &

Busy Indicator Delay
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ii. Implement the Button business logic calling the NodeJS server side and Service Layer.

Explanation Screenshot
Select Outline tab, 01 0= &
sap.m.Button. controls  Outling Properies  Events
Open Events tab. = 2 < Title B
Search a Search for event name Q
Click on the Press event ~ Detaisview sl Press
z ~ sap.mApp

A ~ pages {DocEntry} - Navigate To

IC(?n and select New v sapmPage CardCod Doclotal o Select Function
Function. > content {CardCode} { gocccﬁjw)} s T

customHeader
~ footer

~ sap.m Toolbar

Open in Editor

Model Context Change

~ content
> sap.mHBox Format Error

subHeader

headerContent Ig Fj nC:! fj Fj nC:s g, Cj g_ Parse Error
Enter onAddFreightPress
as the function name. :

Mew Funciion
This function will be called
V_Vhen the event Pre_ss Is The new funclion will be added to the controlber of the cument view
fired on the AddFreight
button. Enter a function name
onAddFreightPress|

Open the
Details.controller.js file |
and scroll down to the
bottom of the file. ondddFreightPress: function{ofvent) |
A new empty function
called onAddFreightPress
has been automatically
created.
Before implementing this — —
function lets add some = SR
definitions to the 1=]zap.ui.defina| apfuifcore/mec/Controller”], function{Controllar)

Details.controller.js file.

Open the
Details.controller.js file.

Remove the code at the
beginning of the file until
“use strict”; as shown here
in the first screen.

Replace that code from by
the one shared at
https://github.com/B1SA/B
1 SCP_HandsOn/blob/ma
ster/snippets/Details.contro

ller.js definitions.js as

function

{Controllar, Messagel

=0 -

use strict”

« JsDNMod=l, jOuery) {
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Explanation

Screenshot

shown in the second
screen.

Let now implement the
function
onAddFreightPress.

When the user clicks on
the AddFreight button we
call the server side
NodeJS to get freight
options.

Replace the URL to the
freight calculator by your
backend application URL
(code marked in red in the
screen capture).

In case of success we call
the function
openFreightDialog.

In case of error we simply
show a MessageToast.

You can get this code from
https://github.com/B1SA/B
1_SCP_HandsOn/blob/ma
ster/snippets/Details.contro
ller.js_onAddFreight.js.
PS: The code contains
more functions than this
one, please copy the full
set of functions. We will
explain each one of the
functions in the coming
steps.

ightPress: function{otvent) {

: Function|

On the Details.controller.js
scroll and search for the
function
openFreightDialog. This
function opens a new
Dialog showing the freight
options returned by the
server side.

This function will use an
xml fragment to design the
freight options dialog.

Edit this function and
change the pointer to the
xmlfragment to match the
name of your namespace
and SAPUI5 application
(you can get this
information from the
beginning of your
Details.controller js file. In
my case it is

war oModel = new sap.ui.model.json. ¥SONModel();

) ':ew.m;lcgl' this);
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Explanation Screenshot
“SaB1SL_SUMM|T_2018 I 515__5\_]".-’\,”1’_2:”3'
view.Dialog”. =
webapp
controller
S5

Let’s add the Fragment
required to show the

Dialog. E viz Pl CHAREN
El  Dialog fragmentg Impart Folder Ciri+Alt+Shift+M
nght click on V|ew_folder B viewl.view:xml Export Project from Template Cir+Alt+EhiTt+HD
and select New->File . R
menu. - Component js Archive Project from Sample Application Wil
= index.himl . . !
= 3 Cut Qauick Start with Layout Editor
= manifestjson
= nomre Gopy Extension Project Ciri+Alt s Shift+E
= Grntfiejs Pasts OP4 Page ai
Give the name
Dlalog.frggment.xml to New File %
the new file.
Press OK. File Manna:
Diatog.fragmentzmi|
Cance

Download the
Dialog.fragment.xml file
from
https://github.com/B1SA/B
1 _SCP_HandsOn/blob/ma
ster/snippets/Dialog.fragme

nt.xml.

Copy the code inside your
Dialog.fragment.xml file.

You can notice in that file
contains the controls of the
Dialog. Also, that file
contains 3 callback
functions will be called for

the events:
- search
- confirm
- cancel

We will implement those
functions in our
Details.controller.js file.

Lo Run indesx html
~ &

Gruntfile js

nes-apE.jsan

1 R R T

package json
BASL_HUB_UIS EX1
B1SL_SUMMIT_2018
.che
= webapp

controller

DCietads confrollenjs

i [

‘iew1 controfer. =
=5
18n
ocalSarvice

7] model

] =l

wifm|
g

=
n
=
=
1

Componant js

W

|
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Explanation

Screenshot

Open the
Details.controller.js file.

The
handleFreightDialogSear
ch (code copied already
earlier) is called when the
user enters data to filter the
list of freight options. The
filter will be based on the
provider property.

The
handleFreightDialogConf
irm function is called when
the user selects one of the
freight options proposed by
the Dialog.

This function calls the
function UpdateSO to
update the Order via
Service Layer API.

The
handleFreightDialogClos
e function is called when
the user closes the Dialog
without selecting a freight
option. A MessageToast
will show to the user the
message “No Provider
selected.”

= function{ofvent) {
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Explanation Screenshot

The updateSO function
calls SAP Business One ;
Service Layer via the SAP
API Business Hub L1
sandbox.

We do an ajax call to the 154
destination 225«
/apihub_sandbox/ 2
automatically created when
we added the Data Source
pointing to the SAP API 138
Business Hub. Then we 211
specify the DocEntry of the 2%
Order to be updated with a
PATCH request.

In case of success we
show a MessageToast
message “SL success”.

In case of error we show a 242 =
MessageToast message i
“SL error”.

function({oota) {

function{e) {

ast. show( "5l

Test your application.

AP Fun indesxhtm
Filter the Orders table with :
DocEntry higher than Title
1211. :
L1211 ®

Please follow directions
from instructors so you DocEntry CardCode DocTotal
only update a specific
Order DocEntry to avoid
conflicts between hands-on
participants.

121 C20000 2,067%

1,213 C20000 2,067%

1,213 C20000 2,067%




Explanation Screenshot

Check the Order DocTotal | ==
before adding the freight A Title
costs.

1,210

C20000 2,067

Add Freight

Select one of the providers.

Select Provider
Search

Provider

USPS
Priority Mail Express

Amount
55.12 USD

USPS

Priority Mail

Amount
7.70 USD




Explanation Screenshot

Check the Order DocTotal
amount is updated after
you select a freight
provider based on the 1210

provider costs.
C20000 2,074.7

(4 Title

You will also see the
success message if the
update of the Order is
successful.

Add Freight

Congratulations! You have just implemented your first full stack loosely coupled SAP Business One
extension!
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